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While Deltek has attempted to verify that the information in this document is accurate and complete, 
some typographical or technical errors may exist. The recipient of this document is solely responsible for 
all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is subject to 
change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are reserved. No part of this 
document may be reproduced or transmitted in any form or by any means, electronic or mechanical, or translated into 
another language, without the prior written consent of Deltek, Inc. 

This edition published May 2018. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and proprietary information of 
Deltek, Inc. and its licensors. The Deltek software, and all related documentation, is provided for use only in accordance 
with the terms of the license agreement. Unauthorized reproduction or distribution of the program or any portion thereof 
could result in severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  
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Overview 
This document is a compilation of the release notes distributed for the enhancements made in Costpoint, 
Budgeting and Planning, and Time & Expense in May 2018. This document includes descriptions of the 
enhancements in relation with system jars, application jars, libraries, and regulatory updates since the last system 
jar release. 

Note: Release notes contain summaries of the enhancements made. Refer to the online help for additional details.  

          Costpoint 7.1.1 Online Help 

http://help.deltek.com/Product/Costpoint/7.1.1/GA/costpoint_help.htm
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Platform Changes 
Display the Company, System, and Environment Names on the Global 
Menu 
To easily identify multiple companies, systems, and environments in Costpoint, you can associate colors with each 
company and define environment and system names. The Configure System Settings (SYMSETNG) screen is updated 
to enable a company to define and display the environment name, and display the system name, on the Global Menu. 
The updates include: 

 A new Environment Name field where you can specify an environment name that displays on the Global Menu. 

 A new Display System in the Header check box to select to display the system name on the Global Menu. 

 The Header Color field, previously called UI Background Color, where you can select a color that displays on 
the Global Menu. The current color associations that were defined using the UI Background Color setting are 
retained. 

 
This enhancement requires the following: 
 PATCH3356 

 cp711_sypcomp_018.zip 

Updated Browse Application Menu 
The Browse Application menu in Costpoint is updated with new domain icons and the new Contracts domain. 

 
This enhancement requires cp711_sys_041.zip. 

WebLogic 12.1.3 and WebLogic 12.2.1.3 April 2018 CPU Support for 
Costpoint 7.1.1 
The Costpoint 7.1.1 Framework installer is updated to include support and compatibility for WebLogic 12.1.3 and 
WebLogic 12.2.1.3 Oracle Critical Patch Update (April 2018). The update aims to address multiple security 
vulnerabilities. 

This enhancement requires the following: 
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 jdk1.8.0_172.exe 

 p27419391_121300_Generic.zip 

Costpoint 7.1.1 Framework Installer Update 
The Costpoint 7.1.1 Framework installer is updated to log an error in the ISS file when the installer detects an invalid 
path to the Costpoint Application install directory. 
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Installation Instructions 
Custom Programs Affected 
Sometimes an update can cause custom programs and reports to stop working as expected. Before applying this 
update, consider whether you have any custom programs or reports in the application area affected by the update. If so, 
contact Deltek Support Center at https://deltek.custhelp.com before you install the update. 

To Download the HotFix/Feature Update: 
1. From Internet Explorer, go to https://dsm.deltek.com. 

2. Click Run Deltek Software Manager. 

3. Log in using your Deltek Support Center credentials. 

4. In the left pane of the Deltek Software Manager, expand your Deltek product. 

5. Expand the Hot Fixes folder for your product, and select the update to download. 

6. Click Download at the bottom of the screen. 

To Install the HotFix/Feature Update: 
Refer to the installation instructions posted on Deltek's Support Center site, https://deltek.custhelp.com. 

 For Costpoint 7.1.1 updates, refer to Knowledge Base article 79232. 

 For Costpoint 7.0.1 updates, refer to Knowledge Base article 73769. 

 For Costpoint 7.0 updates, refer to Knowledge Base article 67722. 

Before you install this update, please review all previous updates in the Knowledge Base article. You may need to install 
prerequisite programs or database patches (described in the Knowledge Base article) prior to installing this update. Note 
that when you download an update using Deltek Software Manager (DSM), all dependent files are automatically 
downloaded. 

To Check to See if the HotFix is Installed: 
1. Open the application that was updated. 

2. Click Help > About Costpoint from the Costpoint toolbar. This will display a screen that shows you the latest 
update JAR for the application that is open, as well as the latest system JAR and all patches applied to the 
system. 

To Check to See if the Feature is Installed: 
1. Click Help > About Costpoint from the Costpoint toolbar. 

2. Open the Features subtask and click the Feature that was just installed. 

3. Open the Applications subtask. Check the list of applications and their corresponding application jars and see if 
they are correct and have been successfully deployed (highlighted in green). 

4. Open the Patches subtask. Check the list of patches and see if they are correct and have been successfully 
deployed (highlighted in green).  

Note: Most of the features installed have their corresponding patches, but not all. 

https://deltek.custhelp.com/
https://deltek.custhelp.com/
https://dsm.deltek.com/
https://deltek.custhelp.com/
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More Information: 
If you have any questions, please contact Deltek Support Center at https://deltek.custhelp.com 

https://deltek.custhelp.com/
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Costpoint 
Accounting 
Ability to Create a Net Entry for Balance Sheet Revaluation 
The Create Revaluation Entry process can be run more than once within the same period. In the current functionality, if 
the original adjusting journal entry (AJE) or balance sheet revaluation (BSR) entry has not yet been posted and the 
previous period’s reversal entry has already been posted, Costpoint deletes the current period’s unposted entry and 
replaces it with the new one. If the original AJE/BSR entry has been posted, Costpoint creates a new one, which 
doubles the amounts previously posted. If the reversal entry from the previous period has not been posted, Costpoint 
deletes that and creates the new entry.  

With this enhancement, the process of creating the entry has been changed so that if an entry has already been posted 
in the current period, the new entry created by Costpoint will be a net entry that takes into account the amounts already 
posted in the current period, but excludes reversal entries previously posted in the current period. 

Several applications have been updated to support this change. 

Configure General Ledger Settings (GLMSETNG) 
A new check box, Create Revaluation as Net, has been added to this screen. Select this check box to create 
revaluation entries at net amounts. If you do not select this check box, revaluation entries will be created at year-to-date 
amounts. 

Create Revaluation Entry (GLPBSREV) 
This application has been updated to create revaluation entries as net entries if the Create Revaluation as Net check 
box is selected on the Configure General Ledger Settings screen. 

Set Up Company (SYPCOMP) 
Set Up Company has been updated to include the value of the Create Revaluation as Net check box when setting up a 
new company or copying settings from one company to another. 

Application JAR Requirement 
This enhancement requires cp711_glpbsrev_010.zip. 

Contracts 
New Contracts Domain: Menu Change 
The Contract Management module previously under the Projects domain is now a separate Contracts domain within 
Costpoint. This enhancement gives the Contract Management solution more visibility and also allows you to quickly 
navigate to the Contract Management solution. 

New modules and application groups have been created to support this update. Eleven applications have been moved 
to the new Opportunities, Contracts, and Resources modules, while the rest of the screens remain in the Contract 
Management Controls module.  
The following image displays the Contracts domain on the Navigation screen. The table that follows lists the modules, 
application groups, and applications available in this domain, listed in order as they display on the UI. 
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Module Application Group Application 

Opportunities Opportunities Manage Opportunities 

Organization Conflict of Interest 
(OCI) 

Manage Organizational Conflict of 
Interest (OCI) 

Opportunities Interfaces Import GovWin IQ Data 

Contracts Contracts Manage Contracts 

Subcontracts Manage Subcontracts 

Subcontracts Reports and Inquiries View Subcontract Inquiry 

Resources Customer/Vendor/Employee 
Information 

Manage Contract Management 
Customer Info 

Approve Prospective Customers 

Manage Contract Management 
Vendor Info 

Approve Prospective Vendors 

Manage Contract Management 
Employee Info 

Contract Management Controls Contract Management Controls Configure Contract Management 
Settings 

Manage Activity Methods 

Manage Activity Subject 
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Module Application Group Application 

Manage Agencies 

Manage Contract Management Roles 

Manage Contract Vehicles 

Manage Document Types 

Manage NAICS Codes 

Contract/Subcontracts Controls Manage Agreement Types 

Manage Contract Date Types 

Manage Contract Status 

Manage Contract Types 

Manage DFARS Library 

Manage FAR Library 

Manage GSA Schedule Codes 

Manage Supplier Vendor Rating 
Codes  

Manage Supplier Vendor Rating 
Descriptions 

Manage Contract User-Defined 
Labels 

Manage Subcontract User-Defined 
Labels 

OCI Controls Manage OCI Reviewer 

Manage OCI Status 

Manage OCI User-Defined Labels 

Opportunities Controls Configure Opportunity Settings 

Manage Opportunity Business Units 

Manage Opportunity Closed 
Reasons 

Manage Opportunity Company 
Responsibilities 

Manage Opportunity Contract Types 

Manage Opportunity Loss Reasons 

Manage Opportunity Sources 
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Module Application Group Application 

Manage Opportunity Stages 

Manage Opportunity Types 

Manage Opportunity Win/Bid 
Probabilities 

Manage Opportunity User-Defined 
Labels 

Patch and System JAR Requirements 
This enhancement requires the following: 

 Costpoint 7.1.1 System JAR 041 (cp711_sys_041.zip) 

 PATCH5116 

 PATCH7148 

Ability to Include DPAS Purchasing Rating on Contracts 
Costpoint now allows you to include the Defense Priorities and Allocations System (DPAS) purchasing rating code 
assigned to a contract. The purpose of the DPAS is to assure the timely availability of industrial resources to meet 
current national defense and emergency preparedness program requirements and to provide an operating system to 
support rapid industrial response in a national emergency. Contract and subcontract administrators can use this 
information in determining their priority when issuing purchase orders.  

Several applications in Costpoint have been updated so you can enter the DPAS number assigned to a contract and 
track it through to the project so that Costpoint Purchasing can pick it up and include it in the purchase order. 

Manage Contracts (CTMCNTR) 
The DPAS Purchasing Rating field is now available on the Contract Info tab of this screen. Use this field to enter the 
DPAS purchasing rating code assigned to the contract.  

The Project Initialization subtask on this screen has also been updated to include the new field when initializing or 
updating projects.  

When you run Project Initialization, Costpoint updates the DPAS Purchasing Rating field on the following screens with 
the DPAS Purchasing Rating value from Manage Contracts for the new or updated projects: 
 Manage Government Contract Information screen  

 Government Contract subtask of the Manage Project User Flow screen  

If the code is not provided in Manage Contracts, users can still enter the DPAS purchasing rating code in Manage 
Government Contract Information or Manage Project User Flow, if applicable. 

Manage Subcontracts (CTMSBCNTR) 
A new field, DPAS Purchasing Rating, has been added to the Subcontract Info tab of this screen to display the DPAS 
purchasing rating code assigned to the subcontract project ID associated with the subcontract record. The value in this 
field is read-only and comes from the DPAS Purchasing Rating field in Manage Government Contract Information or 
Manage Project User Flow. 

Patch and Other Requirements  
This enhancement requires the following:  
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 PATCH3453  

 Common library - PJMASSADD (cp711_cmnlib_PJMASSADD_005.zip) 

Application JAR Requirements 
The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR version for 
each application, if applicable: 

Domain Module Application ID Application Name Application File 

Contracts Contracts CTMCNTR Manage Contracts cp711_ctmcntr_006.zip 

Contracts Contracts CTMSBCNTR Manage 
Subcontracts 

cp711_ctmsbcntr_006.zip 

 

Patch 3466 
PATCH3466 has been released in preparation for the future enhancements for the Manage Opportunities, Configure 
Opportunity Settings, Manage Opportunity Stages, and Manage DFARS Library screens. 

Patch 3467 
PATCH3467 has been released in preparation for the future enhancements for the Configure Opportunity Settings 
screen and for an upcoming new screen in the Contracts domain. 

Patch 3468 
PATCH3468 has been released in preparation for the future enhancements for the Manage Subcontracts screen. 

New Contracts Domain: Application Changes 
The Contract Management module previously under the Projects domain is now a separate Contracts domain within 
Costpoint. This enhancement gives the Contract Management solution more visibility and also allows you to quickly 
navigate to the Contract Management solution. 

Applications in the New Modules 
With this enhancement, new modules and application groups have been created under the Contracts domain. The 
following applications, previously under the Contract Management Controls (CT) module, are now displayed in the new 
Opportunities (OP), Contracts (CN), and Resources (RE) modules: 

 Opportunities module  

 Manage Opportunities (CTMOPP)  

 Manage Organizational Conflict of Interest (OCI) (CTMOCI)  

 Import GovWin IQ Data (CTPIQDAT)  

 Contracts module  

 Manage Contracts (CTMCNTR)  

 Manage Subcontracts (CTMSBCNTR)  

 View Subcontract Inquiry (CTQSUBC)  

 Resources module  

 Manage Contract Management Customer Info (CTMCUST)  
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 Approve Prospective Customers (CTMCUSTA)  

 Manage Contract Management Vendor Info (CTMVEND)  

 Approve Prospective Vendors (CTMVENDA)  

 Manage Contract Management Employee Info (CTMEMPL)  

The rest of the screens in the Contracts domain remain in the Contract Management Controls module. 

Note: It is important to note that while Import GovWin IQ Data now displays in the Opportunities module, access to this 
application is still under the Contract Management Controls module in this release. Access to this screen will be set 
under Opportunities in a succeeding release.  

Use the Manage Users and Manage User Groups screens in the Admin domain to review or modify user and user group 
access rights to the modules. 

Print Menu Report (SYRMENU) 
A new check box, Contracts, has been added to the Options group box of this screen to allow you to include the 
Contracts domain and its modules when you print Costpoint menu information. 

Patch Requirements 
This enhancement requires PATCH3424.  

Application JAR Requirements  
The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR version for 
each application, if applicable.  

Domain Module Application ID Application Name Application File 

Contracts Opportunities CTMOCI Manage 
Organizational 
Conflict of Interest 
(OCI) 

cp711_ctmoci_005.zip 

Contracts   Opportunities   CTMOPP   Manage 
Opportunities  

 cp711_ctmopp_006.zip  

Contracts   Contracts   CTMCNTR   Manage Contracts   cp711_ctmcntr_006.zip  

Contracts   Contracts   CTMSBCNTR   Manage 
Subcontracts  

 
cp711_ctmsbcntr_006.zip  

Contracts   Contracts   CTQSUBC   View Subcontract 
Inquiry  

 cp711_ctqsubc_002.zip  

Contracts   Resources   CTMCUST   Manage Contract 
Management 
Customer Info  

 cp711_ctmcust_005.zip  

Contracts   Resources   CTMCUSTA   Approve 
Prospective 
Customers  

 cp711_ctmcusta_004.zip  
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Domain Module Application ID Application Name Application File 

Contracts   Resources   CTMEMPL   Manage Contract 
Management 
Employee Info  

 cp711_ctmempl_004.zip  

Contracts   Resources   CTMVEND   Manage Contract 
Management 
Vendor Info  

 cp711_ctmvend_005.zip  

Contracts   Resources   CTMVENDA   Approve 
Prospective 
Vendors  

 
cp711_ctmvenda_004.zip  

Admin   System 
Administration  

 SYRMENU   Print Menu Report   cp711_syrmenu_002.zip  

 

Projects 
Transfer of the Contract Management Module as a New Domain 
The Contract Management Module has been removed under the Projects domain and is now a new Costpoint domain.  

People 
Updated Header and Instructions on Life Events and Benefits Enrollment 
The Life Events/New Hires screen and the Benefits Enrollment screen now provide more information on the screen 
header and in the Instructions tab. To support this enhancement, this Costpoint release applies the corresponding 
changes to the following applications: 

Life Events/New Hires (ESMLIFEEVENT)  
 The Life Event, Life Event Date, and Status fields now display in the header across the top of the screen.  

 The header displays the following additional information:  

 Employee Last Name  

 Employee First Name  

 Employee ID  

 This Instructions tab now discuss the following:  

 Selection of benefits  

 Negative amounts for premiums  

 Saving dependent/beneficiary changes  

Benefits Enrollment (ESMBENENROLL) 
 The header information now displays across the top part of the screen.  

 The field label changed from “Open Enrollment Period” to “Open Enrollment Period Start and End Dates” fields. 
This field is now included in the header.  

 The field label changed from “Effective Dates” to “Benefits Start and End Dates.” This field is now included in the 
header.  
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 The Instructions tab now discuss the following:  

 Selection of benefits  

 Rollover of benefits  

 Negative amounts for premiums  

 Saving dependent/beneficiary changes  

Application JAR Requirements 

Domain Module Application ID Application Name Application File 

People  Employee Self 
Service  

ESMBENENROLL  Benefits Enrollment  cp711_esmbenenroll_014.zip 

People  Employee Self 
Service  

ESMLIFEEVENT  Life Events/New Hires  cp711_esmlifeevent_018.zip  

Regulatory and Compliance 
IMPORTANT NOTES  
Versions 7.0.1 and 7.1.1 - Calendar Year End 2018  
In an effort to allow adequate time to prepare for future year-end system jar requirements, please be aware that you 
must have the following System JARs loaded before the Calendar Year End 2018 release which is scheduled for 
December 2018. Appropriate action should be taken throughout the next months to plan for this System JAR 
requirement. 

Anticipated Calendar Year End 2018 System JAR Requirements  

 Costpoint 7.0.1: System JAR 054 (to be released June 2018)  

 Costpoint 7.1.1: System JAR 028 (released April 2017)  

Version 7.1.1 – Further Reductions in the Need to Release Regulatory Updates within System JARs  
We are happy to announce that we have made several programming changes within the past year to limit the need for 
regulatory changes to be released via System JAR. System JAR 028 for Costpoint 7.1.1 was part of that effort. The 
coding changes introduced in System JAR 028 for Costpoint 7.1.1 allowed us to disassociate payroll computation coding 
changes from future 7.1.1 System JAR releases. So, after System JAR 028, changes to Costpoint version 7.1.1’s 
Compute Payroll application will not require deployment via System JAR as they did in the past. This means that we can 
deploy Costpoint 7.1.1 regulatory updates and fixes more quickly, and help us keep the System JAR requirements for 
Calendar Year End releases as minimal as possible. 

2018 May Tax Table Update  
This Costpoint release includes regulatory changes for May 2018.  

Idaho 
Idaho's withholding tax tables were updated to reflect new tax laws. To be able to use the 2018 withholding tables in 
payroll, this release adds new records effective January 1, 2018 for Idaho on the Manage State Taxes screen and 
Manage State Tax Tables screen.  

The following are tax updates to Idaho:  

 Withholding tables for Single and Married have been updated.  

 One withholding allowance is now $2,960.  

 Supplemental withholding rate decreases from 7.4 percent to 6.925 percent.  
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Note: For more information, please refer to A Guide to Idaho Income Tax Withholding: 
https://tax.idaho.gov/pubs/EPB00006_04-27-2018.pdf. 

Utah 
Utah's withholding formula was updated to account for the recent changes in the federal tax law. To be able to use the 
2018 withholding formula in payroll, this release adds new records, effective May 1, 2018, for the Utah on the Manage 
State Tax Withholding Adjustments screen and Manage State Tax Tables screen. 

The following are the tax updates for Utah:  

 Flat income tax rate decreases from 5 percent to 4.95 percent.  

 Withholding tables for Single and Married were updated.  

Note: For more information, please refer to the Utah Withholding Tax Guide: https://tax.utah.gov/forms/pubs/pub-14.pdf. 

HotFix Requirements 
These enhancements require the following Costpoint 7.1.1 releases:  

 PATCH3459  

 PATCH3471 

  

2018 Colorado Tax Table Update  
In response to the federal tax code overhaul (Pub. L. 115-97), the Colorado Department of Revenue announced an 
update to their allowance table on April 2, 2018 (effective April 1, 2018). The amount per allowance will remain 
$4,050.00 for each allowance up to 6 allowances, but the amount will differ for 7 or more allowances.  

To be able to use the 2018 exemption amount for employees claiming more than six allowances, this Costpoint release 
adds a new allowance table for Colorado on the Manage State Tax Withholding Adjustments screen.  

Allowance Table (for wages paid on or after April 1, 2018) 
If the number of withholding allowances is: Total amount of withholding allowance for the payroll 

period (Annually) 

0  $0  

1  4,050  

2  8,100  

3  12,150  

4  16,200  

5  20,250  

6  24,300  

7  22,950  

8  21,600  

https://tax.idaho.gov/pubs/EPB00006_04-27-2018.pdf
https://tax.utah.gov/forms/pubs/pub-14.pdf
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If the number of withholding allowances is: Total amount of withholding allowance for the payroll 
period (Annually) 

9  20,250  

10  18,900  

Over 10  Use the amount for 10 allowances in the appropriate 
payroll period.  

 

Note: For more information please refer to the table in the Colorado Income Tax Withholding Tables for Employers 
guide: https://www.colorado.gov/pacific/sites/default/files/DR1098.pdf. 

Screen Updates  
This Costpoint release applies the corresponding updates to the following screens for this enhancement:  

Compute Payroll (PRPCPR)  
The application was updated to retrieve the correct personal exemption amount from Manage State Tax Withholding 
Adjustments application for Colorado. 

Manage Employee Earnings History (PRMERF)  
A new column was added to the work tables used by the application’s common code.  

Manage Payroll Records (PRMPTF)  
The application was updated to retrieve the correct personal exemption amount from Manage State Tax Withholding 
Adjustments application for Colorado.  

Manage State Tax Withholding Adjustments (PRMSTAC)  
A Number of Exemptions or Credits field allows you to enter the number of exemptions or credits if the tax allowance 
option in the Type field is Personal Exemption Allowances.  

Print Data Dictionary Report (SYRDD)  
The application report now includes information for the Number of Exemptions or Credits (EXMPT_OR_CREDIT_NO) 
field in the State Tax Allowances and Credits (STATE_TAX_ALL_CR) table.  

Print Quarterly Federal Payroll Tax Report (PRRFDTAX)  
A new column was added to the work tables used by the application’s common code.  

Print Soc Sec and Medicare Reconciliation Report (PRRFICA)  
A new column was added to the work tables used by the application’s common code.  

Recompute Taxable Wages (PRPRCOMP)  
A new column was added to the work tables used by the application’s common code. 

HotFix Requirements  
These enhancements require the following Costpoint 7.1.1 releases:  

 System JAR 028  

 PATCH3396  

 PATCH3465  

https://www.colorado.gov/pacific/sites/default/files/DR1098.pdf
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 Common Lib - CPCPR (cp711_cmnlib_CPCPR_011.zip)  

Note: If any of the following updates apply to your company, you must install the corresponding patch before installing 
the May 2018 Colorado tax table update:  

PATCH3374 — New York, Ohio & Wyoming SUTA Wage Base  

PATCH3385 — Virgin Island SUTA Wage Base / Oregon & Virgin Island State Tax  

PATCH3401 — Louisiana Withholding Tax  

PATCH3459 — Utah & Idaho State Tax  

PATCH3471 — Utah State Tax  

If you attempt to install these patches after installing the May 2018 Colorado tax table update, the state updates will not 
be properly implemented.  

Application JAR Requirements  
The following table shows the required application JAR version for each screen affected by this update: 

Domain Module Application ID Application Name Application File 

People  Payroll  PRPCPR  Compute Payroll  cp711_prpcpr_023.zip  

People  Payroll  PRMERF  Manage Employee 
Earnings History  

cp711_prmerf_014.zip  

People  Payroll  PRMPTF  Manage Payroll 
Records  

cp711_prmptf_018.zip  

People  Payroll  PRMSTAC  Manage State Tax 
Withholding 
Adjustments  

cp711_prmstac_007.zip  

People  Payroll  PRRFICA  Print Soc Sec and 
Medicare 
Reconciliation 
Report  

cp711_prrfica_010.zip  

People  Payroll  PRPRCOMP  Recompute Taxable 
Wages  

cp711_prprcomp_007.zip  

 

Note: System JAR 054 for Costpoint 7.0.1 introduced an update to the Colorado state tax withholding tables. In 
response to the federal tax code overhaul (Pub. L. 115-97), the Colorado Department of Revenue announced an update 
to their Allowance table on April 2, 2018 (effective April 1, 2018). This required an update to Costpoint Compute Payroll, 
which can only be released through a System JAR in Costpoint version 7.0.1.  

System JAR 049 for Costpoint 7.0.1 and System JAR 028 for Costpoint 7.1.1 introduced a much needed change to 
the State Filing Statuses in Costpoint. Rather than using filing statuses that only applied to Costpoint (Both, 
Miscellaneous 1, Miscellaneous 2, etc.) and had to be manually mapped to each state’s actual filing statuses, Costpoint 
7.0.1 and 7.1.1 have been updated to use each state’s actual filing status(es). Though the new filing statuses were 
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introduced in April 2017, Deltek will continue to support tax table updates based on the original state filing statuses for 
the remaining 2018 tax updates. Any tax updates for 2019 will only support the new state filing statuses that were 
introduced in System JAR 049 for 7.0.1 and System JAR 028 for 7.1.1 (both released in April 2017).  

Paid Family Leave Phase 2: Ability to Compute Leave for a Single Leave Type 
This Costpoint enhancement will allow HR Administrators to compute leave accruals for a single leave type in the 
Compute Leave (LDPCLHF) application. This can be useful if you need the employee to have an accrual before 
timesheets are entered or imported. For example, You can use this functionality if your employee has a leave type for 
Paid Family Leave that must be accrued before it can be charged on timesheets, but the employee also has a leave 
type that is based on hours worked and must be computed after timesheets are entered or imported. 

Screen Updates 
The Costpoint release applies the corresponding updates to the following screens for this feature: 

Compute Leave Accruals 
The screen now allows you to compute leave accruals for all or a single leave type. To support this functionality, the 
following Leave Type fields are now available in the Selection Range group box: 

 Range Type — From the drop-down list, select the range of leave types to be computed. Valid options are All 
or One.  

Select One when you have a leave type that must be computed before or after an employee’s other leave types. 
If you select One as the range type, enter the leave type to be computed in the leave type Start field.  

 Start — If you select One in the Range Type field, enter, or use Lookup to select, the leave type to be 
computed. This field is enabled only if the Leave Type - Range Type is One.  

Note: If your employee has multiple leave types and you only compute leave for one of those leave types, you will still 
be able to compute the other leave types in the future. However, please note that the same leave type cannot be posted 
to Leave History more than once for the same employee and leave period. 

Application JAR Requirements 
The following table shows the required application JAR version for the screen affected by this update. 

Domain Module Application ID Application Name Application File 

People Leave LDPCLHF Compute Leave 
Accruals 

cp711_ldpclhf_015.zip 

 

Materials Management 
Organization Security 
The Organizational Security feature enhances the secure functionality of Costpoint by warranting proper user access 
throughout the Production Control (PC), Purchasing (PO), and Receiving (RC) modules. This feature ensures that 
correct user access is applied to the logged-in user ID in accessing parts, projects, requisitions, and purchase orders by 
validating and filtering records/transactions as authorized for the user ID. 

Patch and System JAR Requirement 
These enhancements require the following:  
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 Costpoint 7.1.1 System JAR 041 (cp711_sys_041.zip)  

 PATCH3390  

 PATCH3397  

 PATCH3405  

 PATCH3403  

 PATCH3413  

 PATCH5109  

 PATCH5111  

 PATCH5118  

 PATCH5119  

Application JAR Requirements 
The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR version for 
each application, if applicable. 

Domain Module Application 
Name 

Application ID Application File 

Materials PC Manage 
Manufacturing 
Orders 

PCMMOMNT cp711_pcmmomnt_030.zip 

cp711_cmnlib_PCMMOLIB_010.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

Materials PC Expedite 
Manufacturing 
Orders 

PCMMEXPD cp711_pcmmexpd_010.zip 

cp711_cmnlib_PCMMOLIB_010.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

Materials PC Enter 
Manufacturing 
Order Issues 

PCMMOIS cp711_pcmmois_023.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

Materials PC Print 
Manufacturing 
Order 
Documentation 

PCRMODC cp711_pcmodc_011.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

Materials PC Create MO 
Subcontractor 

PCMSCRQ cp711_pcmscrq_015.zip 

cp711_cmnlib_MMPFPOLIB_005.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

Materials PC Enter 
Manufacturing 
Order Reliefs 

PCMRELMO cp711_pcmrelmo_020.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

Materials PC Manage MO 
Operation 
Completions 

PCMCOMP cp711_pcmcomp_001.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

cp711_cmnlib_PCMSFR_006.zip 
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Domain Module Application 
Name 

Application ID Application File 

Materials PC Manage MO 
Quality Control 
Inspection Results 

PCMINSP cp711_pcminsp_001.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

cp711_cmnlib_PCMSFR_006.zip 

Materials PC Print MO WIP 
Variance Analysis 
Report 

PCRWIPV cp711_pcrwipv_003.zip 

Materials PC Create MO WIP 
Variance Journal 
Entry 

PCPWIPV cp711_PCPWIPV_007.zip 

Materials PC Print 
Manufacturing 
Order Component 
Shortage Report 

PCRSHRT cp711_pcrshrt_005.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

Materials PC Print 
Manufacturing 
Order Cost Report 

PCRMOCST cp711_pcrmocst_008.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

Materials PC View 
Manufacturing 
Order Status 

PCQMOST cp711_pcqmost_010.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

Materials PC Update 
Manufacturing 
Order Costs 
Labor Costs 

PCMMOLAB cp711_pcmmolab_008.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

Materials PC Update 
Manufacturing 
Order Costs 

PCMMCOST cp711_pcmmcost_004.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

Materials PC Load MO WIP 
Accounts 

PCPTOOL cp711_pcptool_003.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

Materials PC Compute Material 
Requirements 

PCPMRR cp711_pcpmrr_015.zip 

cp711_cmnlib_MMPFPOLIB_005.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

Materials PC Manage Planners PCMPLNR cp711_pcmplnr_003.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 

Materials PC Load 
Organizations IDs 

PCPLDORG cp711_pcpldorg_001.zip 

Materials PC Manage Inventory 
Abbreviation 
Peggings 

MRMIAPEG cp711_mrmiapeg_006.zip 

cp711_cmnlib_MMORGSECLIB_001.zip 
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Domain Module Application 
Name 

Application ID Application File 

Materials  PO  Manage Purchase 
Orders  

POMMAIN  cp711_pommain_037.zip  

Materials  PO  Print Purchase 
Orders  

PORPPO  cp711_porppo_021.zip  

Materials  PO  Manage Buyers  POMBUY  cp711_pombuy_004.zip  

Materials  PO  Update 
Subcontract 
Retainage PO 
Status  

POMSCST  cp711_pomscst_009.zip  

Materials  PO  Approve Pending 
Purchase Orders  

POMSTAT  cp711_pomstat_011.zip  

Materials  PO  Approve Pending 
Purchase Orders  

POMRELS  cp711_pomrels_020.zip  

Materials  PO  Expedite 
Purchase Orders  

POMEXPD  cp711_pomexpd_010.zip  

Materials  PO  View Purchase 
Order Change 
Orders  

POQCHNG  cp711_poqchng_008.zip  

Materials  PO  Archive Purchase 
Orders  

POPARCH  cp711_poparch_011.zip 

Materials  PO  Manage Purchase 
Orders Expediting 
Notes  

POMEXPN  cp711_pomexpn_003.zip  

Materials  PO  Print Purchase 
Order Expediting 
Report  

POREXPD  cp711_porexpd_007.zip  

Materials  PO  Create Purchase 
Order Change 
Orders  

POMCHNG  cp711_pomchng_015.zip  

Materials  PO  Print Purchase 
Order Change 
Orders  

PORPCO  cp711_porpco_016.zip  

Materials  PO  Manage 
Statement of 
Work  

POMSOW  cp711_pomsow_002.zip  

Materials  PO  Change Purchase 
Order Type  

POPTYPE  cp711_poptype_004.zip  
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Domain Module Application 
Name 

Application ID Application File 

Materials  PO  Print Purchase 
Order Activity 
Report  

PORACTV  cp711_poractv_008.zip  

Materials  PO  Print Purchase 
Order Register 
Report  

PORREG  cp711_porreg_008.zip  

Materials  PO  View Item 
Purchasing 
Information  

POQITEM  cp711_poqitem_009.zip  

Materials  PO  Load Organization 
IDs  

POPLDORG  cp711_popldorg_001.zip  

Materials  PP  Create Purchase 
Orders  

PPPGPO  cp711_pppgpo_021.zip  

Materials  RC  Manage Quality 
Control 
Inspections  

RCMINSP  cp711_rcminsp_023.zip  

Materials  RC  Print Receipt 
Traveler  

RCRTRVLR  cp711_rcrtrvlr_010.zip 

Materials  RC  Manage Purchase 
Order Receipts  

RCMPORC  cp711_rcmporc_023.zip  

Materials  RC  Print Pending 
Inspection Report  

RCRPINSP  cp711_rcrpinsp_004.zip  

Materials  RC  Print Receiving 
Log  

RCRLOG  cp711_rcrlog_005.zip  

Materials  RC  Manage Vendor 
Returns  

RCMRTRN  cp711_rcmrtrn_017.zip 

 

For more information about the Organization Security for the Production Control, Purchasing, and Receiving modules of 
the Materials domain, see the Deltek Costpoint 7.1.1 Release Notes: Organization Security – Production Control, 
Purchasing, and Receiving document. 

Load Organization IDs (PPPLDORG) 
Use this new screen (Materials » Procurement Planning » Procurement Planning Utilities » Load Organization 
IDs) to load requisitioner’s organization to a requisition where the field is left blank. This utility will not overwrite existing 
requisition organization in requisition records. 

Note: You must run this utility before turning on organization security for a module. If you skip this process, query result will exclude 
transactions with blank organization IDs 

Load Organization IDs (ECPLDORG) 
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Use this new screen (Materials » Engineering Change Notices » ECN Utilities » Load Organization IDs) to load 
originator’s organization to Engineering Change Notice (ECN) where the field is left blank. This utility will not overwrite 
existing originator organization in ECN records. 

Note: You must run this utility before turning on organization security for a module. If you skip this process, query result will exclude 
transactions with blank organization IDs 

DVGMRSUBLIB Library 
The DVGMRSUBLIB library contains common business logic which is shared by the following applications: 

 Manage MRP Action Messages (MRMACTM)  

 Manage Master Production Schedule Action Messages (MSMACTM)  

 Manage Detailed Part Schedule (MRMDTPT)  

 Manage Master Production Schedules (MSMMPS)  

 View Summary Part Availability (MRQSPA) 

Application JAR Requirement  
The following table shows the required application JAR affected by this update. 

Domain Application Name Application JAR 

Materials Manage Detailed Part Schedule 
(MRMDTPT) 

cp711_mrmdtpt_017.zip 

System JAR Requirements 
The following Costpoint 7.1.1 system jar files and patch are required for this update: 

 cp711_cmnlib_DVGMRSUBLIB_001.zip  

 cp711_sys_041.zip 

 

Administration 
View Help About (SYMABOUT) 
The Features subtask in View Help About (SYMABOUT) now includes the Organization Security feature for the 
Purchasing, Receiving, and Production Controls module. 

Reports & Analytics 
Manage CER Settings 
The new Manage CER Settings (BIMCERSETTINGS) screen has been added in preparation for an upcoming change to 
Costpoint Enterprise Reporting (CER). This screen would allow the selection of the data source for project budget 
reporting in CER which can either be Costpoint or Budgeting and Planning. You can also enable security for future 
models and reports that will be added to CER. 

As default, model security will be enabled which at the same time will turn off the Cognos framework model security. 
You can turn off the model security anytime through this new screen. 
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Note: Although this screen is already available in the Reports and Analytics domain, it has no impact on the current 
functionality of CER yet. A future version of CER will be required for this screen to take effect 

System Requirements 
This enhancement requires the following: 

 PATCH3324.sql 

 PATCH3402.sql 

 PATCH7149.sql 

Application JAR Requirement 

Domain Module Application ID Application 
Name 

Application File 

Reporting & 
Analytics 

Configuration BIMCERSETTINGS Manage CER 
Settings 

cp711_bimcersettings_001.zip 
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Budgeting and Planning 
Project Budgeting  
Import Multiple Budgets/EACs from Excel 
A new Projects » Project Budgeting » Controls and Utilities » Import Budget/EACs from Excel utility was added 
that enables you to import multiple project budgets and EACs from Excel and then upload them to the Project 
Budgets/EACs application. 

The Excel template has been formatted by Deltek for this purpose. The template, available from the Excel Template 
subtask, includes column headings that correspond to fields within the Project Budgets/EACs application. 

Previously, you could only import projects one at a time using the Import Budget/EAC from Scheduling App (BPU1, 
BPU3, BPU5, NPU1) screen. The ability to import multiple project budgets/EACs is presently limited to Excel. 

The Import Budget/EACs from Excel application provides users with the capability to perform the following functions: 

 Download the pre-formatted Excel template. 

 Upload data from Excel to Budgeting & Planning. 

 Select error reporting and duplication parameters, and after the upload is finished, review the results in the 
Upload Report subtask prior to uploading the data to the Project Budgets/EACs application. 

 Review errors using the Error Report subtask. 

 Commit multiple budgets simultaneously to Budgeting and Planning. 

Administrator Prerequisites 
Information in this section applies primarily to system administrators.  

 Users must save the completed template as an .xml data file prior to upload.  

If the .xml file extension does not exist in in the File Upload Limits table of the Admin » System Administration » System 
Administration Controls » Configure System Settings screen, it must be added. 

 Users must save the .xml file to a specified Alternate File Location for the application to access it for processing. 
If you have not yet configured the Alternate File Location, see online help for Administration » System 
Administration » File Management » Manage Alternate File Locations. See also the note in the Preparing 
Your Data for Upload section below. If a common network location will be used for this purpose that location 
should be made known to users of this application.  

 An Import Budget/EACs from Excel Commit Flag Default check box was added to Admin » Budget 
Administration » Administration Controls » Configuration Settings (MAM10) » Project tab. When you 
select this option, the Commit check box on the Upload Report subtask is selected by default, but the user can 
change the status.  

Preparing Your Data for Upload 
To upload your data into the Import Budget/EACs from Excel utility,you must start by entering your project 
budgets/EACs into a Deltek-formatted Excel template. A link to the template is available from the Excel Template 
subtask on the Import Budget/EACs from Excel screen. 

To download the Excel template, complete the following steps: 
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1. Click Projects » Project Budgeting » Controls and Utilities » Import Budget/EACs from Excel to display the utility. 

2. Click the Excel Template subtask link. 

3. In the Excel Template subtask, copy the URL and paste it into a web browser. 

4. Save the template to your specified location. 

To finalize the template for use in the Import Budgets/EACs from Excel utility, complete the following steps: 

1. Enter budget/EAC data in the spreadsheet. 

2. In Excel, save the template as an .xml file type. If you are unfamiliar with this process, refer to the Excel online 
help. 

To be uploaded within the Import Budget/EACs from Excel utility, the .xml file must be available in a preconfigured 
location within Costpoint, referred to as an Alternate File Location.  

When you save the template as an .xml file, you must either save it to the Alternate File Location, or copy it there using 
File Upload on the Process menu. If you do not know the Alternate File Location, check with your System Administrator. 

Upload and Process Your Data 
In the Import Budget/EACs from Excel screen, you will set validation parameters, select error report settings, and then 
select the location where the .xml file was saved. 

 
 

To import multiple budgets/EACs, complete the following steps: 
1. From the If a Budget/EAC already exists, do you want validations to create an error when Uploading File? 

drop-down list, choose one of the following: 

 Yes — If a budget/EAC already exists an error will result. 

 No — If you select this option, proceed to Step 2.  

2. From the If a Budget/EAC already exists, do you want to drop-down list, choose one of the following 
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 Overwrite entire Budget/EAC — For Budgets, the budget for the entire period of performance, 
including past, current and future periods, will be overwritten by the .xml uploaded file 

o If the existing Budget/EAC status is Complete, Incomplete, or Working, a Working version is 
created with the same version number. The old copy of the version remains available to 
view until the new Working version is committed. 

o If the existing Budget/EAC is ‘Approved,’ a new Working version will be created with a new 
version number.  

This field is disabled if you select Yes from the If a Budget/EAC already exists, do you 
want validations to create an error when Uploading File? drop-down list. 

 Append current and future periods — For Budgets/EACs, the current and future period Budget will 
be updated by the .xml upload. Prior Periods will not be changed. If an .xml file is uploaded with Prior 
Period changes, then an error is created during validation 

3. From the If validation finds an error drop-down list, choose one of the following: 

 Fail all – view items in error report - All .xml lines will fail if a single error is found. 

 Upload passes – view failed items in error report - Only .xml line items not included in the error 
report are uploaded, with the rest displayed in the error report. 

4. Upload the .xml data using one of the following methods: 

 In the Location field, click  to select the location from the list of Alternate File Locations already 
designated within Costpoint, and in the Name field, click  to select the file.  

 On the Process menu, click File Upload, and in the File Upload Manager screen, click Browse to 
select the .xml file. 

5. Click Upload File. 

6. If errors occur, click the Error Report subtask link to view them. 

Reviewing Errors and Uploading Using the Upload Report Screen 
After the .xml file is successfully uploaded in the Import Budget/EACs from Excel screen, it is automatically processed. 
Depending on validation settings, the Budgets/EACs that did not contain errors are either uploaded immediately to the 
Project Budgets/EACs application as budgets with a Working status, or all the budgets/EACs fail if any errors exist. 

The Upload Report subtask displays the budgets/EACs that were successfully uploaded. From that same subtask, you 
can also commit selected budgets/EACs. After you commit, the status of the uploaded budget/EAC in the Project 
Budgets/EACs application changes from Working to Incomplete. 

You can review error messages on the Error Report subtask. Using the information available on this subtask as a guide, 
you can make corrections to your original entries in the Excel template, and then re-run the process until you have 
successfully imported all Budgets/EACs into the Project Budgets/EACs application. 

Error Report Subtask: Review Upload Errors 

 Project ID/Period End Date 

 ID Type 

 ID 

 Pool Org ID 

After the budgets and EACs in the .xml file are processed, any of those that failed display on the Error Report subtask. 

Fields that display on the Error Report subtask are identical to those in the Excel template. 

The Error Report Subtask table displays ten columns to help you identify and address budget errors: 
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 Account ID 

 PLC 

  Rate 

 Hours 

 Amount 

 Detailed Error Message 

 

 

 Project ID – this column displays one row per Project ID uploaded. 

 Errors –  this column displays one of two values: 

 Yes indicates that the project budget has partially uploaded but has errors. 

 No indicates that the project budget has completely uploaded.  

The Error Report subtask is operative only if users have selected the Upload passes – view failed 
items in error report option in the If validation finds an error dropdown list. The other available 
option is for all to fail on validation error 

 Budget Type – This column displays the budget type (BUD or EAC). 

 Version – This column displays either the version number of the Working budget/EAC that will be 
overwritten or the version number of the newly created budget/EAC that will be committed in the 
Upload Budgets/EACs process. 

 Commit – This column displays a check box that is selected, or left clear, by default. Though the 
default setting is specified in the Configuration setting, it can be modified here. 

 Click Upload File to update budgets and EACs. 

Requirements 
The enhancement requires cp711_bnp_common_006.zip. 

Budget by Resource 
The Add/Edit/Delete Assignments subtask in Budget By Resource now includes a Type column where you can 
select the type of budget.  After you click New in the subtask, you will have to select the Budget Type. Choose from 
Project, Proposal or Non-Backlog budget type. 

Also, the Source column now displays BUD (Project Budget), EAC, PRP (Proposal) or NBL (Non-Backlog). 

A Query was added to the result set screen to further filter the results.  The query criteria are the column headers. 

Application JAR Requirements 

Use the Expand All and Collapse All buttons to maximize and minimize the error list. 

Upload Report Subtask: Review the Budget Date Upload Results 
You can use the Upload Report subtask to view the result set after the upload completes. The subtask table includes 
five columns: 
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The following table shows the required application JAR version for the screens affected by this update: 

Domain Module Application ID Application Name Application File 

Projects Project 
Budgeting 

bnp_bgmbpir.htm Budget by Resource cp711_bnp_common_008.zip 

Budgeting Administration 
Changes to Configuration Files 
As Budgeting & Planning 7.0 is now integrated into the Costpoint database, many of the Configuration Settings are 
duplicates of settings already in Costpoint.   

In this release, files associated with configuration changes were modified to avoid redundancy and unused codes were 
removed due to obsolete values. 

Application JAR Requirements 
The following table shows the required application JAR version for the screens affected by this update: 

Domain Module Application ID Application Name Application File 

Admin Budgeting 
Administration 

BNP_BAMMAM10 Configuration Settings 
(MAM10) 

cp711_bnp_common_008.zip 

Admin Budgeting 
Administration 

BNP_BAMMAP1 Manage Project Direct 
Cost Type Table (MAP1) 

cp711_bp_bnp_bammap1_001.zip 

Admin Budgeting 
Administration 

BNP_BAPREFRES
H 

Refresh Process cp711_bp_bnp_baprefresh_006.zip 

Dependent File: 

cp711_bnp_common_005.zip;cp711
_bp_patch1280_001.zip 

Accounting Organizational 
Budgeting 

BNP_BGMAOM3 Organization Budget 
Cycle Initialization 
(AOM3) 

cp711_bp_bnp_bgmaom3_003.zip 

Accounting Organizational 
Budgeting 

BNP_OAQXOPX Plug Project Review 
(NOP1,NOI1,AOP1,AOP
2,AOP3) 

cp711_bp_bnp_oaqxopx_001.zip 

Projects Project 
Budgeting 

BNP_SRQSPA5 Project Status (SPA5) cp711_bp_srqspa5_002.zip 

Accounting Organizational 
Budgeting 

BNP_OAPAOI1 Compute Forward Rates 
(AOI1) 

cp711_bp_bnp_oapaoi1_002.zip 

Projects Project 
Budgeting 

BNP_BGMBPUX Import Budget - EAC 
From Scheduling App 
(BPU1,BPU3,BPU5,NPU
1) 

cp711_bp_bnp_bgmbpux_003.zip 

Changes to Project Tab  
The Project Budget Account Type field and drop-down menu was removed from the Project tab of Configuration Settings 
(MAM10) because in Budgeting & Planning 7.0, the Project Account Group (PAG) from the Costpoint project setup will 
be used by budgeting. 
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Time and Expense 
Time 
There are no updates in this area. 

Expense 
There are no updates in this area. 

Configuration 
There are no updates in this area. 
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